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Chapter 1 — Installation

1-1 Introduction
Mobile InterferenceHunter (MIH) is a Microsoft Windows application drivers tool for locating RF interference 
sources. It runs on a laptop or tablet computer and can connect to Anritsu handheld spectrum analyzers 
through an Ethernet cable, a Wi-Fi capable Anritsu Spectrum Analyzer, or a travel router. The system 
displays multiple indicators of power levels which aid in determining the location of the interfering signal 
source. 

This chapter details the initial setup of the hardware, software, and interfaces to the instrument and its RF 
connections. Chapter 3, “MIH Graphical User Interface” describes the software user interface and features. 
Chapter 4, “Hunting Interference Signals” describes how to perform specific tasks within the Mobile 
InterferenceHunter software.

1-2 System Requirements 
Operate the Mobile InterferenceHunter with a mobile computer in a vehicle using an Anritsu supported 
instrument. MIH will also run on a desktop PC and can be used this way to review saved drive test data. 
Anritsu sells several compatible antennas to cover a wide range of frequencies. Our antennas include both the 
RF and GPS antennas integrated into a single convenient package. Other options are also possible. 

The following is the recommended minimum equipment to operate the system in the field:

• MX280007A InterferenceHunter™ software 

• Anritsu handheld spectrum analyzer with automotive DC power adapter
(refer to https://www.anritsu.com/en-us/test-measurement/products/mx280007a for compatible 
instruments)

• Windows 7, 8, or 10 tablet or laptop meeting the following minimum requirements:

• Quad core processor (> 1 GHz)

• 4 GB RAM, 500 MB storage space

• Ethernet or Wi-Fi

• Internet connection (if using Google/Baidu Maps or the TDOA feature)

• Off-line maps

• DC power adapter for the tablet or laptop

• TP Link Model TL-WR802N pocket router and cables (2000-1752-R) or 
Ethernet crossover cable.

• RF/GPS antenna (must use an instrument mounted GPS antenna or Anritsu PC GPS receiver)

• Combination RF and GPS antenna for your instrument (2000-1647-R)

• GPS receiver for PC (2000-1528-R, required if your instrument does not have GPS)

• RF cable compatible with your instrument if using a vehicle mounted RF antenna of your choice

Recommended Accessories:

• Yagi antenna

• Mounting Hardware (2000-1801-R)
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1-3 Installing the MX280007A Mobile InterferenceHunter Software
1. Place the software installer (MIH_Installer_Vx.xx.msi) on your Windows tablet/laptop and double-click 

the icon "MIH_Installer_Vx.xx" (where x.xx is the current software version number).

2. Follow the instructions presented by the installer. If this is a first time installation, you may be 
prompted to install NI-VISA Runtime if not previously installed. NI-VISA Runtime is bundled with the 
MIH installer.

3. Once completed, a green icon will then appear on your screen. Double-click the green Mobile 
InterferenceHunter icon to run the program. 

1-4 Installing the License Key
A license key is needed to run the Mobile InterferenceHunter (MIH) program. When the Mobile 
InterferenceHunter software is purchased, an email with the license key and instructions are sent to you. The 
license key must be associated with just one Anritsu instrument, but it can be used on multiple computers. The 
license key may have an expiration date. Please retain the license key as it allows you to use the instrument 
associated with this key on other tablets or PCs. 

Import Licenses and drag-and-drop are two methods of importing the license key into Mobile 
InterferenceHunter. Follow the instructions below to import the license key into the program.

Import License

1. Under the File | Licensing menu, click Import Machine License to open the folder containing the license 
key that activates the features of Mobile InterferenceHunter.

2. Highlight the license file and click Open. The license will be entered into the MIH program.

Drag-and-Drop License

Depending on the email service, drag-and-drop the attached license key into MIH. 

• If using Google/Baidu Maps, drag-and-drop the license key anywhere on the MIH software except for on 
the Google/Baidu Map itself.

• If using maps from any open source map, drag-and-drop the license key anywhere on the MIH program 
window.

Figure 1-1. Importing the License Keys
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1-5 Configuring the Computer to Instrument Connections
This section details two methods of connecting Mobile InterferenceHunter software to an Anritsu handheld 
instrument Ethernet port. For detailed instructions to configure your instrument, please review the user guide 
specific to your instrument. The procedures below are examples. Other configurations are possible depending 
on your needs and available resources.

Connecting via an Ethernet Crossover Cable

1. Connect the laptop to the instrument Ethernet port with a crossover cable.

2. Set the host PC to a static IP address as follows:

a. Click Start Menu > Control Panel > Network and Sharing Center. 

b. Click Change adapter settings.

c. Right-click on Local Area Connection and click on Properties.

d. Select Internet Protocol Version 4 (TCP/IPv4), click Properties, and then set the following:

• IP Address = 10.0.0.1 

• Default Gateway Address = 10.0.0.0 

• Subnet Mask = 255.255.255.0

3. Set the Anritsu handheld instrument Ethernet settings as follows:

a. Open the System menu via Shift System (8).

b. Click the System Options menu.

c. Click Ethernet Config and set the following:

• IP Address = 10.0.0.2 

• Default Gateway Address = 10.0.0.0 

• Subnet Mask = 255.255.255.0 

4. Open a browser on the computer and enter the URL address 10.0.0.2 to access the handheld instrument 
web interface.

Connect to Analyzers with Built-in Wi-Fi

Anritsu Products, such as the MS2090A, have built-in Wi-Fi and do not require a router to be remotely 
connected to a PC/tablet running the MIH software. A hotspot or access point is required for communications 
to take place. To learn more about your Spectrum Analyzer and the Wi-Fi connection, visit the Anritsu Product 
Page at: https://www.anritsu.com/en-US.

Configure the Spectrum Analyzer 

1. Connect the PC/tablet used with MIH to a hotspot. 

2. Test the connection by using a Ping command to log into the IPV4 IP address.

3. Locate the Wi-Fi connectivity setting of your spectrum analyzer.

4. Activate the Wi-Fi setting of the spectrum analyzer. Once Wi-Fi is active, a listing of the SSID names 
will appear based on the Wi-Fi signals that are present.

5. Click the SSID name corresponding to the SSID of your hotspot.
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Test the connection to MIH 

1. Click Settings at the top of the MIH screen.

2. Click on the Spectrum Analyzer Connection in the menu list.

3. Click on the Test Connection button. You should then receive a message back that the test has passed. A 
successful connection dialog with the analyzer IP address will display similar as shown in Figure 1-2.  

Connecting via the TP Link TL-WR802N Wireless Router

The router comes factory configured to work with Anritsu instruments. A band pass filter on the input to the 
spectrum analyzer may help with weak signals when using a Wi-Fi link.

1. Set the Anritsu handheld instrument Ethernet settings as follows:

• IP Address = 192.168.0.50 

• Default Gateway Address = 0.0.0.0 

• Subnet Mask = 255.255.255.0 

2. Connect both the Ethernet and USB ports between the router and instrument.

3. Connect the laptop to the router via Wi-Fi (generally using the icons in the lower right system tray) 
using the SSID and password that are printed on the router label. These codes are unique for each 
router. For example:

• SSID = TP-LINK_39DE

• Password = 02850450

4. Open a browser on the computer and enter the URL address 192.168.0.50 to access the handheld 
instrument web interface.

Recover the TP Link Factory Configuration.

1. Connect the laptop to the router through Wi-Fi as described in Step 3 of the previous procedure.

2. Open a web browser and enter the URL address tplinkwifi.net (192.168.0.1 or 192.168.0.254 are router 
default IP addresses, which will be changed later in the procedure).

3. Log in to the router using the defaults:

• Username: admin 

• Password: admin 

4. Click Quick Setup.

5. Set the Router as an Access Point and continue to click Next until the Quick Setup is done.

6. Review the settings and then reboot the router using the on-screen Reboot button.

7. Connect as described in the previous procedure.

Figure 1-2. MIH Connection Setup Dialog
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Connecting MIH Ethernet to a Spectrum Analyzer

In the MIH Settings menu, click Spectrum Analyzer Connection mode to set up the Ethernet connection with 
the instrument as shown in Figure 1-3. The IP address dialog will display similar as shown in as shown in 
Figure 1-2. 

1. Type in the IP address of the instrument or the Wi-Fi router. 

2. Click Test Connection to confirm connectivity. Once the Ethernet connection is complete and verified, 
begin taking measurements. 

1-6 Setting Up an Alternate Ethernet Connection
Following the steps below, it is possible for the Laptop / Tablet PC used with MIH to have a primary Ethernet 
configuration (for the office network) and an alternate Ethernet configuration (for use with MIH). By doing so, 
there should be no need to re-configure network settings each time the Laptop / Tablet is used with MIH. 
Windows will detect the connected network and switch to the appropriate Ethernet configuration 
automatically.

No changes will be made to the General (primary) settings. Only an Alternate configuration will be added. This 
process assumes a static IP network configuration as the alternate network communication method between 
MIH and the spectrum analyzer. A CAT5 cable will be used to connect the spectrum analyzer to the PC. Note 
that the spectrum analyzer’s Ethernet configuration type will be set to ‘Manual’ and the IP address, Gateway, 
and Subnet set per the examples below.

Example IP addresses, Subnet Mask, and Gateway:

• Spectrum Analyzer IP address: 192.168.0.100

• MIH PC address: 192.168.0.99

• Subnet Mask: 255.255.255.0

• Gateway: 192.168.0.1

Figure 1-3. Spectrum Analyzer Connection
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PC Ethernet Adapter Settings

For the Laptop / Tablet PC, navigate to Network Settings.

1. Click the Ethernet connection. 

2. Click Properties.

3. Click Internet Protocol Version 4.

4. Click Properties.

Figure 1-4. PC Ethernet Settings Window

Figure 1-5. PC Ethernet Status and Properties Windows
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From Internet Protocol Version 4 Properties: 

1. Click the Alternate Configuration tab. 

2. Check the User configured radio button. 

3. Enter the IP address, Subnet mask, and Default gateway as shown in Figure 1-6.

The Laptop / Tablet PC is now be capable of utilizing either of the two network settings. General configuration 
for the office network or MIH Alternate Configuration, depending on which network it is connected.

Figure 1-6. Internet Protocol Version Properties Window
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1-7 Setting Up an External USB GPS Antenna
A GPS receiver is required for proper operation. If your instrument is equipped with a GPS option, use a GPS 
antenna connected to the handheld instrument and go to “From the MIH program:” on page 1-9. Otherwise, 
use an Anritsu GPS receiver connected to the computer USB port. MIH currently supports the BU-353S4 GPS 
receiver (Anritsu part number 2000-1528-R). Set up the receiver.

1. Download and install the latest driver from the GPS manufacturer’s website to the tablet or laptop that 
will be used in finding an interferer. (Anritsu has tested Prolific driver version 3.8.1.3.)

2. Attach the external GPS receiver to the computer’s USB port.

3. Confirm that Windows has installed the hardware driver and that it is listed under Ports (COM & LPT) 
in the Windows Device Manager.

4. Right-click on its listing followed by clicking on Properties to verify the device is working properly and 
that the Port Setting are configured as shown below (4800/8-N-1).   

Figure 1-7. Communication Port (COMx) Properties Window
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From the MIH program: 

5. Click GPS Configuration in the Settings menu. 

6. Click the GPS antenna option. 

7. Click Start in the MIH USB GPS Communication Setup. The antenna will search for satellites and 
obtain a GPS Fix.

8. Click Ok.

When using the GPS receiver with the computer, the Mobile InterferenceHunter main status bar at the 
bottom-left of the window has a GPS satellite fix indicator that can also show how many satellites are being 
tracked.   

To discontinue GPS antenna communication:

9. Open the dialog. 

10. Click Stop.

Figure 1-8. MIH USB GPS Communication Setup Window

Caution
The USB GPS communication must be running and the setup window must be closed by clicking Ok 
before data collection can be started.

Figure 1-9. GPS Satellite Fix Indicator

Gray: GPS is not active or no satellite fix

Light Red: Less than 3 satellites are fixed

Yellow: 3 satellites are fixed

Green: More than 3 satellites are fixed
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Additional Documentation

This MIH User Guide is part of a set of manuals that describe all of the remote spectrum analyzer functions 
and their use with MIH. Instrument operations of various document types are listed below.

The MIH compatible instruments and their documents azre listed below. 

Contacting Anritsu for Sales and Service

To contact Anritsu, visit the following URL and view the services in your region:
http://www.anritsu.com/contact-us

Document Part Number Description 

10100-00064 Important Product Information, Compliance, and Safety Notices

10580-00419 MS2710xA Remote Spectrum Monitor User Guide

10580-00428 SpectraVision User Guide

10580-00435 MX280001A Vision Programming Manual

10580-00420 MS2710xA Maintenance Manual

10580-00444 MS2090A Field Master Pro User Guide

11410-00898 MS27100A Spectrum Monitor Module Technical Data Sheet

11410-00853 MS27101A Indoor Remote Spectrum Monitor Technical Data Sheet

11410-00847 MS27102A Outdoor Remote Spectrum Monitor Technical Data Sheet

11410-00854 MS27103A Remote Spectrum Monitor Technical Data Sheet

11410-01000 MS2090A Field Master Pro Technical Data Sheet
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Chapter 2 — Loading Maps

2-1 Loading Maps Into MIH
Loading or creating a map is essential when using the Mobile Interference Hunter. Ready-made maps are 
available for cities throughout the world on the Anritsu website. Visit http://www.anritsu.com and search for 
Maps. Alternately, construct your own maps using the brief instructions provided in the following sections for 
each mapping solution, or by visiting the map provider’s website for their latest features.

Mapping solutions available using Mobile InterferenceHunter:

• OpenStreetMap™ – See “Using OpenStreetMap™” on page 2-2.

• Map Puzzle – See “Install Map Puzzle™” on page 2-3.

• Google Maps™ and Baidu Maps – See “Using Google/Baidu Maps” on page 2-5.

• Map Image Maps – See “Map Image Files (User Provided)” on page 2-5.

Load a Map Into Mobile InterferenceHunter

After selecting a map source from this section, load the user defined map as follows.

1. Click, drag, and drop the downloaded map file onto the Mobile InterferenceHunter program screen.

2. Open the downloaded map from the Mobile InterferenceHunter Settings menu as follows:

From the main menu: 

3. Click: Settings | Map Source | Open Source Maps (User provided) (see Figure 2-2)

4. Browse to your download folder.

5. Open the file.

Note The downloaded map cannot be dropped directly on top of a Google/Baidu Map.
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2-2 Using OpenStreetMap™
Use the OpenStreetMap web site to create and download your map (https://www.openstreetmap.org). 

Once on the OpenStreetMap site as shown in Figure 2-1, follow the instructions provided by OpenStreetMaps 
to download a map.

When you open OpenStreetMap in Mobile InterferenceHunter software, a dialog box prompts you to enter the 
city and country. Then, the map is converted to the Mobile InterferenceHunter format and opened in the 
software. The converted files are saved so that when you open that location in the future, no additional 
formatting is needed.

Figure 2-1. OpenStreetMap Website

Figure 2-2. Map Source - Open Source Maps 
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To open existing maps, navigate to the directory on your tablet/laptop where the maps are stored and open any 
SHP file for your map. See Figure 2-3 where 'roads.shp' is highlighted in yellow for illustration. 
InterferenceHunter will use all of the map files in the directory for the various map layers.

2-3 Install Map Puzzle™
Users may want to use their own mapping solutions. Here we will describe the use of Map Puzzle. Map Puzzle 
is a free program for Windows to download maps from Google, Bing, and other public mapping services. For 
more information not covered in this section using Map Puzzle, visit http://www.mappuzzle.se/doc.htm.

Figure 2-3. Open Source Maps

Figure 2-4. Map Puzzle User Interface
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Run the executable to load the Map Puzzle interface as shown in Figure 2-4. Maps are also supported in the 
Anritsu Simulator program and the Anritsu TDOA Demo Application.

1. Copy mappuzzle.exe on to the local drive. 

2. Type the coordinates settings of the map location.

3. Type the Image Settings for the zoom level, Width and height of the map as it will appear on the screen.

4. Click the Map Selections arrow to see more options. The map service section provides a list of map 
services to select from.

5. Click the Format arrow to see more options. Selections include .jpg, and .png.

6. Click Download.

• The map will take a short amount of time to download. The loading green-bar indicator and the 
amount of time remaining for the download process to complete is indicated by the Map Puzzle 
user interface as shown in Figure 2-5. 

Once the download is complete, the map file is stored in the downloads folder as shown in Figure 2-6. 

1. Map Puzzle Title Bar

2. Map Service Download

3. Map Format 

4. Download Button

5. Image Settings

6. GPS Coordinates

Figure 2-5. Download Map In-Process

Figure 2-6. Download Complete

Figure 2-4. Map Puzzle User Interface

C:\Users>Downloads

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Loading Maps 2-4 Using Google/Baidu Maps

MX280007A UG PN: 10580-00416  Rev. F 2-5

2-4 Using Google/Baidu Maps
Using Google/Baidu maps requires an Internet connection for the duration of the interference hunt. A USB 
modem can be used with the laptop/tablet if your device does not have an integrated radio.   

Navigate to Settings | Map Source | Google Maps or Baidu Maps. The Google/Baidu map is then automatically 
displayed.

2-5 Map Image Files (User Provided)
MIH creates a location on the PC to store and retrieve MIH map files: C:\[user documents folder]\Anritsu 
MapFiles. Although the user is not limited to this location, this is the location MIH looks to find map files. 

The Open Map Image File (User provided) menu selection provides a browse menu for the user to select a 
previously loaded JPG or PNG file. If the user selects a file not previously loaded, they will be requested to 
enter the GPS coordinates of the corners of the map. See “Enter Map Edge Coordinates” on page 2-6.

Installed Map Image File menu selection provides quick access and opens a sub-menu that lists all of the JPG 
and PNG files in the Anritsu MapFiles folder. See Figure 2-7. The user can immediately search for and open a 
map file. If it is the first use of the Image Map file, then the user is prompted for the GPS coordinates of the 
corners. See “Enter Map Edge Coordinates” on page 2-6.

Note Ensure that the USB modem’s radio signal is not interfering with the signal you are trying to find.

Figure 2-7. Installed Map Image Files
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2-6 Enter Map Edge Coordinates
Initially a new map is not pointed to the exact coordinate location. When loading a new map in MIH, a dialog 
box is displayed requesting the user to Enter Map Edge Coordinates as shown in Figure 2-8. To enter the 
coordinates: 

1. If using MapPuzzle, go to the MapPuzzle download status box and scroll up to the beginning of the 
download process.

2. Copy the latitude and longitude coordinates in one mouse sweep. 

3. Go back to the Enter Map Edge Coordinates dialog box and click paste. The copied coordinates will paste 
into the coordinate fields. 

4. Click OK. 

Using a map file source other than Map Puzzle may require the user to enter the map edge coordinates 
manually.  

Note

If a user downloads more than one map, the status box will contain information about each 
download. Scrolling back to the top and copying coordinates will copy the coordinates of the first 
map downloaded, not the most recent. The user needs to only scroll up to the top of the most recent 
download, or press the 'Clear Log' button in Map Puzzle before each download.

1. Enter Map Edge Coordinates dialog

2. Copy Coordinates

3. Paste Coordinates

Figure 2-8. Enter Map Edge Coordinates
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Chapter 3 — MIH Graphical User Interface

3-1 Introduction
The Mobile InterferenceHunter software controls Anritsu Handheld Spectrum Analyzer products that can be 
run from a Windows-based desktop, laptop, or tablet computer via Ethernet connectivity. The main window is 
consists of a:

• Title bar

• Menu bar

• Vertical tool bar

• Signal display windows

• Drive map display

• Status bar 

Figure 3-1. Main Window

Power vs. Time
Display 

Trace Data Realtime
 Power Meter/Flux Density

Power
Scale 

Drive Map
Display

Menu
Bar

Status Bar

Demo Remote Host

9

Tool
Bar
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3-2 Tool Bar
The toolbar is at the left edge of the Mobile InterferenceHunter application window. Use the Settings | Button 
Size menu option to adjust the screen size. Each Toolbar button is detailed below.

Icon Description

Start Scan Driving: Scan driving is a search method that looks for an interferer in a general 
area. The dark lavender shaded area on the drive map indicates areas where more data is 
required. Scan driving is used more to eliminate areas where the interferer is not likely located, 
rather than to locate the interferer directly. Begin with this mode and drive a wide area in the 
direction of the darkest map shading. Once no longer areas of dark shading are visible, switch 
over to Spot driving mode for a more targeted hunt to the interferer. The button turns yellow 
when connecting and green when active.

Start data collection: Begins data collection of real-time power and GPS coordinates. When 
moving, data will display in the Time vs. Power bar graph and breadcrumbs are displayed in the 
drive map. As a safety feature, the menus in the Menu bar are deactivated and not accessible in 
the Run mode. If the message “Spectrum Analyzer Not Responding” pops up, there is no 
connection to an instrument. The button turns yellow when connecting and green when active.

Pause data collection: Stops data collection and communication between the computer and 
Spectrum Analyzer. Click this button at the end of an interferer hunt or to halt data collection. An 
example for pausing data collection is going over an overpass will increase the received power 
even though you are not closer to the RF source. The menus in the Menu bar are reactivated for 
use.

Clear Data: Click to clear all data collected. Removes all data from the active data set. When 
hunting interfering sources, some data may be erroneous due to various sources for example 
attenuation, reflection, multi-path, and fading. As power level increases and direction becomes 
clearer you may want to purge old data and start fresh. It is recommended that you always clear 
the data buffers before starting a new hunt.

Zoom In: Click to zoom into the map. This button replaces the Zoom In control within the maps. 
It is easier to access. The map will recenter in relation to the Green Car.

Zoom Out: This button replaces the Zoom Out control within the maps. The map will recenter 
in relation to the Green Car.

 

Auto-Centering: When active, the auto icon on the map and its location will return to the center 
of the display window after having moved 50% and beyond the center of the display. Also at this 
time, the center of the button is green. The button turns green when active. Auto-centering can 
be turned on before running data collection or during data collection. When Auto-Centering is 
off, you will have to manually drag the auto icon into view. 

Toggle Trace Data: View the spectrum trace. The placement of the spectrum analyzer 
instrument may not be in a convenient location for viewing when interference hunting. The 
Instrument Trace button allows you to view the signal within the Mobile InterferenceHunter 
window. This window will be updated approximately once per second. 

Also in this mode, a snapshot of the trace will be taken per measurement taken during data 
collection and will be stored as a .jpg file. View the traces during a log playback or manually 
viewing a log file. When scrolling through the signal lines in the Power vs. Time display, the 
trace associated with that signal line will be displayed in the Instrument Trace Display.
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3-3 Menu Bar
The menu bar extends across the top of the application window and includes four menu categories: File, View, 
Mode, Settings and Help. This section describes the basic set of menu items. These menus are disabled when 
MIH is in either run modes.

File Menu

Open Log File (Ctrl+O): Opens the file directory to load a saved drive test data set (.log file). This is useful for 
reviewing test results and documenting hunting excursions. Log files can be opened or appended to 
existing data to aggregate multiple runs. The log file can also be opened as a playback file. A playback 
file is like reviewing the gathered data as a movie.

Save Log File (Ctrl+S): Saves the current drive test data set. If you clear the data, you will not be able to get it 
back unless it has been saved. Saved data is only useful to reload and review previous interferer hunts.

Create a Drive Route: Opens the dialog box shown in Figure 3-3. Follow the instructions provided to create a 
drive route. The drive route can be created at the office and then sent to the technician out in the field. 
The field tech-supervisor and field technician should be signed into the same Google Maps account. 

Export Drive Log to KML

Export a drive test log to a (.kml) file. See “Export to KML” on page 3-5.

Import Location Estimate: The location files (.loc) were produced by the Anritsu Vision software. The 
estimated locations are a result of the different techniques used to locate an interferer:

• Angle of Arrival (AoA)

• Power on Arrival (POA)

• Time Difference of Arrival (TDOA)

Figure 3-2. Menu Bar

Figure 3-3. Creating Drive Routes Instructions
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Once imported, the data from .loc files will be displayed on the Drive Map Display. Use this information 
to create a drive route. 

Capture Screen (Ctrl+C): Captures the current map display and saves it to the directory folder labeled Anritsu 
ScreenShots. The captured screen is in PNG format and labeled with the date and time stamp. 

Screen Capture Folder: Opens the file directory containing all of the captured screens. The directory folder is 
labeled Anritsu ScreenShots.

Save Current Settings: Opens the Save As window. Name the file and click Save. The file extension.mih, will 
be added to the end of the name given. Most MIH settings and key instrument settings are saved.

Recall Saved Settings: Opens the Open window containing all of the configuration settings files. These MIH 
files are located in the default directory folder, My Documents.

Recent Settings: Opens a list of up to 10 previously saved Settings files.

Save Setup on Spectrum Analyzer: Initiate a save setup on the instrument from the MIH software. Click to 
open the Filename dialog and enter a name for the setup file to be saved on the instrument. After the 
setup name has been entered, click OK.

Recall Setup on Spectrum Analyzer: Use this command to load a setup on the instrument for measurement 
testing. Click to open the Select a Setup File dialog. A list of Setup files on the instrument is displayed. 
Click the desired setup file then click the Load button.

Licensing: Opens a list of commands related to instrument licenses:

• View Licenses (Ctrl+V): Opens the About Anritsu Mobile InterferenceHunter dialog. It contains the lists 
of single instrument license keys and/or network license keys currently in use. 

• Import Machine License(s): Click to import a single instrument license key.

• Export Licenses: Creates a file containing all of the licenses on that PC that can be imported to another 
PC. Note that a license can be associated with only one Anritsu instrument.

Exit: Closes the Mobile InterferenceHunter program. Any data collection not saved will be erased at this time.

Note
The Anritsu ScreenShots folder is created during the installation of Mobile InterferenceHunter and is 
placed in the My Documents folder.
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Export to KML

A drive test log can be exported to a (.kml) file. Open a drive log to view in the MIH window. From the File 
menu, click “Export Drive Log to KML”. Name and save to a (.kml) file. Click to open the (.kml) file to provide 
the drive route in a Google Earth format as shown in Figure 3-4.

Channel Power

To view the channel power of a particular breadcrumb as shown in Figure 3-5, the Trace Data window must be 
active. To activate, click “Toggle Trace Data” from the MIH “Tool Bar”. The data shown in the Trace data 
display is then available to view when a (.kml) file is opened. 

Clicking a breadcrumb then displays the signal’s channel power trace data and the power readout. The 
direction links are provided through Google. Click ‘To here’ to enter a starting location. Click ‘From here”, to 
enter a destination.  

Figure 3-4. Export Drive Test to KML

Figure 3-5. Channel Power

Drive Test KML 
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View Menu

Button Size: Click a button size. The four selections are 32 x 32, 64 x 64, 96 x 96, and 128 x 128. The buttons 
will scale to fit the toolbar if the button size selected is larger than what can be accommodated by the 
toolbar size. Expanding the window size will grow the size of the buttons until they reach the maximum 
size selected.

Menu Font Size: Click a font size for text in the Menu Bar, its sub-menus and in the Status Bar and most 
dialogs. The font sizes are 9, 10, 11, 12, 14 and 16. The font size affects the amount of information 
displayed on Status Bar. As the font size increases, status parameters may be removed from view.

Growing Breadcrumbs: Breadcrumbs are placed on the map along your traveled route. In its default setting, 
breadcrumbs’ color changes but may still be difficult to see while driving. The breadcrumb size increases 
as received power increases. With Growing Breadcrumbs set, breadcrumb power levels are denoted not 
only in color but with size.

Estimation Circle: A red and green circle appears as more breadcrumbs with higher power levels are left on 
the map. When the position of the signal source becomes available, the Green Arrow is eliminated and 
replaced by the Circle. The Circle may be large at first but will reduce in size as more signal data is 
accumulated. This indicates that you are closer to the interfering signal source and that the power level 
of the interferer is increasing. Also, the default colors of the circle area colors red and green and can be 
change in the Color Mode setting. 

From the center of the circle looking out, the green areas of the circle depict how the breadcrumbs are 
dispersed for calculating the location of the interfering signal. If the Circle is heavily shaded red or one 
side of the Circle is a quarter to half shaded green then drive in the direction of the area shaded red to 
accumulate a more even distribution of breadcrumbs to calculate the location of the interferer. The 
Estimation Circle is not available in Multiple Emitter and Spectrum Clearing Modes. (For Drive Map 
Display, click to view either the Estimation Circle or the Heat Map. The Estimation Circle is the default 
view).

Heat Map: The Heat Map covers a larger area of displaying the level of intensity of the interferer signal by 
color than the Estimation Circle. A matrix of rectangles creates the heat map and the colors signify the 
probability that the pattern of observed power measurements would be caused by an emitter in that grid 
cell – green being the strongest signal and pale blue/gray the weakest signal. (For Single Emitter Mode, 
click to view either the Estimation Circle or the Heat Map. The Estimation Circle is the default view).

Allow Level Adjustment: Places a bright blue horizontal line in the Power vs. Time display. Click and move it 
up or down. Changing the horizontal location of the line changes the threshold level and data used for 
determining either the Estimation Circle or Heat Map.

Show Cross Hairs: Adds a horizontal and a vertical line that cross at the best estimated location of the 
interferer.

Show Line Estimates: Line Estimates are used for determining the location of an interferer. Green lines are 
drawn perpendicular to the vehicle’s direction of travel. Line Estimates can only be used in Single 
Emitter Mode. To use Line Estimates, click Show Line Estimates (F11) command.

Toggle Current Line Estimate: Toggles on or off the setting for the current measurement as indicated by the 
bright yellow vertical line in the Power vs. Time display. Move the bright yellow vertical line using the 
left/right keyboard keys or by clicking on the bar chart. When toggled on, the color of the bar highlighted 
by the bright yellow vertical line changes to a pale blue. Also with Show Line Estimates on, a green line 
is drawn on the map perpendicular to the direction of travel at that location. This should only be done at 
local maxima and where the vehicle is traveling in a straight line on the bar chart. When performed so 
that the lines cross at nearly right angles, the intersection of the lines will mark the position of the 
interferer.

Clear All Line Estimates: Toggles off all green line estimates. 

Clear Location Estimate (Imported or TDOA): Clears location line estimate from the map. When you run 
TDOA or import TDOA data, location estimate lines are drawn on the map that triangulate an 
interferer. These lines persist until MIH is closed or until this menu item is used.

GPS Coordinate Format: Click either Decimal degrees or Degrees, Minutes, Seconds format. 
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Color Mode: Click a color when viewing the drive map in changing lighting conditions. In cases such as using 
the instrument in bright sunlight, use the High Contrast (Transparency) setting.

• Map Colors: Full Color or Reduced Color

• Estimation Circle: Green/Red, Blue/Yellow, Black/White, High Contrast Transparency

• Base Station Icons: Aquamarine, Green, Orange, Red, Blue, Tan, Yellow

Mode Menu

Scan Driving (Initial Perimeter Survey): Used to establish a general area of where an interfering signal may 
be found.

Spot Driving: Single Emitter (Standard Operation): Hunting for a single interfering signal.

Multiple Emitter: Click opens a dialog with sliding scale as shown Figure 3-6. Enter the height (in dB) that a 
peak must rise above a local minimum on either side to be considered and emitter source. 

Signal Peak: The signal peak is the strongest signal that rises above the threshold of the nearest minimum 
power point of either side of the peak signal. This peak signal would be an emitter signal.

Car Position Slider: Move the bar with the mouse pointer to scan the signal strengths. Move the car through 
the breadcrumbs to find the location of the peak signal.

Peak Signal Location: The peak signal locations highlighted in the bar graph are identified by the red X on 
the map.

1. Signal Peak

2. Car Position Slider

3. Peak Signal Location

Figure 3-6. Multiple Emitter Mode

1 2

3
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Spectrum Clearing: Opens the dialog and sliding scale as shown in Figure 3-7. The colored power scale 
appears at the top right corner of the user screen disappears. 

Type the threshold power in (dBm). The threshold power level entered is represented by a horizontal line 
across the channel power display. The breadcrumbs will be red (above threshold) or green (below 
threshold).

Screen images are automatically saved when the threshold is exceeded.  

Time Difference of Arrival (TDOA): Use TDOA to locate interference sources and other modulated 
broadcasters. TDOA is not a driving mode like the other modes mentioned above. For TDOA, you must 
stop the car to perform the measurement. You must also have access to at least three remote spectrum 
monitor probes (MS2710xA). Note that one MS2710xA probe can be used as a spectrum analyzer for 
normal interference hunting. Refer to “Setting Up TDOA” on page 4-12.

Figure 3-7. Spectrum Clearing Mode Screen
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Settings Menu

Map Source: Click a map source to use in the map display, Google/Baidu maps or a map from Open Source 
Maps. If using Open Source Maps, then switch to Google/Baidu Maps and want to return to the same 
Open Source Map, just click Show Current OSM Map to view the same OSM map without reloading. To 
view the list or load a new OSM map, click Installed Map Files. Click to load the new OSM map.

Google Maps (Internet Connection Required): Opens Google Maps.

Baidu Maps (Internet connection required): Opens Baidu Maps.

Open Source Maps (User Provided): Directs user to Open Source Map file location.

Show Current OSM Map: Displays the current Open Source map. 

Installed Map Files: Displays the file directory of the user installed map files.

Open Map Image File (User Provided): Browse for a map file to load.

Installed Map Image Files: Provides a sub menu with existing map files in the default map folder. 
(Documents\Anritsu MapFiles)

Import Base Stations (Open Source only): Opens the Import Base Station dialog to load a list of base stations 
onto the driving map. The file with the extension .lst is a text file which contains the latitude, longitude 
and the name of the site. This file can only be overlaid onto OSM map files. Refer to “Creating, 
Importing, and Viewing Base Stations (Open Source Only)” on page 4-2.

View Base Stations on Map if Present: Toggles base stations location icons on the map display. For details on 
downloading maps, see: https://www.anritsu.com/en-US/test-measurement/products/Maps. 

Spectrum Analyzer Connection: Opens the MIH Connection Setup dialog to set up the Ethernet connection to 
an Anritsu spectrum analyzer. 

1. Enter the IP address of the instrument. 

2. Click Test Connection to confirm connectivity. 

3. Click OK to return to the main screen. 

GPS Configuration: For Anritsu Handheld instruments without an internal GPS receiver, this setup allows 
you to use an external USB GPS antenna. The default setting is Instrument GPS. See “Setting Up an 
External USB GPS Antenna” on page 1-8.

Power Detection Mode:  This menu becomes available after connecting to a MS2090A through the “Spectrum 
Analyzer Connection” menu. Used when performing flux density measurements. See the detailed 
description at Section 4-16 “Flux Density” on page 4-13. The submenus are:

1. Channel Power 

2. Flux Density (dBm/m2/MHz)

3. Flux Density (dBW/m2/MHz)

Audio Tones: Tones fluctuate in pitch relative to the power level received which can be seen in the Real-Time 
Power Meter. The higher the power level the higher the tone pitch and most likely the closer the 
interferer signal. The audio tone update is approximately once every 100 ms but is considerably slower if 
the Spectrum Display is on.

Voice Prompts: Voice Prompts are given at fifteen second intervals and will point you in the general direction 
towards the interference source. When activating Voice Prompts, a voice will inform you that Voice 
Prompts is on.

Voice Selection: Mobile InterferenceHunter provides options for voices to use as voice prompts. Click:

• Microsoft David Desktop

• Microsoft Zira Desktop

Other voices are commercially available from various vendors should you find the Microsoft voices not 
understandable.
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Min/Max Hold: Click to display sub-menu with Normal Trace, Min Hold, or Max Hold functions. A timer 
control located at the top corner of the MIH window appears, as shown in Figure 3-8, when Min/Max is 
selected and can be set from 1 to 15 seconds.

Squelch Limit: Displays the dialog shown below. Set a minimum power signal threshold with squelch limit. 
Click On to activate the squelch limit value. This value appears with the Squelch Limit menu in the 
Setting menu list.

Any signal below squelch limit will be ignored during the data collection. This value is typically a few dB 
above the instrument noise floor. Measured with Channel Power for the current setup. Refer to Allow 
Level Adjustments control in the “View Menu” for doing this post-acquisition.

The squelch limit value will appear with the Squelch Value menu in the Setting menu list.

Sensitivity: Sensitivity relates to how data is collected in different types of geographical areas. In urban areas, 
small fluctuations in the receive power are more likely to be caused by a reflected or attenuated signal. 
We do not want to use these fluctuations in the location algorithm, so we lower the sensitivity by 
smoothing the data set. In rural areas there are fewer obstacles so small changes in the receive power 
are more likely to be of interest. We use higher sensitivity (less smoothing) so these small changes can 
help locate the interference source.

In urban canyon settings, the GPS signal can suffer from multi-path, and a stopped vehicle can appear to 
wander some distance from its true location. Decreasing sensitivity in urban areas increases the 
minimum distance the vehicle’s position must change to be considered moving. In the case of 0, No 
Sensitivity (zero averaging), the data displayed will be raw data taken. No averaging has been applied to 
the data collected. Select the environment type that closely resembles the area that an interferer is being 
hunted. Sensitivity is only used for Single and Multiple emitter Modes. It does not apply to Spectrum 
Clearing Mode.

Along with the Sensitivity settings there is a Peak Detection Threshold setting. Before a location 
estimate is made, it is important to have enough useful data that an estimate is of value. The algorithm 
requires a peak in power to be detected, indicating that you have at least driven somewhere in the 
neighborhood of the interference source. If the threshold (power above background) for this peak is too 
low you will get false positives, meaning a location estimate based on multi-path or other environmental 
effect, rather than the true interferer location. 

When seeking low power sources, it is sometimes necessary to lower the peak detect threshold in order to 
get a position estimate at all. Generally, it is best to start with the Peak Detect Threshold set to High, 
and only lower it if you feel certain you are in the right area, but still not seeing a location estimate. 

Note Using this feature lengthens the data collection time. You will need to reduce your driving speed.

Figure 3-8. Min/Max Timer Control
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Both the Sensitivity and Peak Detect Threshold affect calculations over the entire data set each time a 
new value is added. The raw power levels are kept in memory. Therefore, changing settings during a 
hunt is perfectly fine. The new value will be applied to the entire data set, and changes are reversible.

Search Grid Width: Changing this setting widens (or narrows) the search grid, the area in which an RF source 
searched. If the RF source is outside of this area, as indicated by a box drawn on screen, it will not be 
located by MIH. MIH only looks inside the search grid area for an interferer. This setting has the same 
effect on both estimation circle and heat map mode.

Log Data While Stopped: Normally, the Mobile InterferenceHunter will not collect data when you come to a 
stop, for example, when stopped at a street light, pulled over for a moment to change settings or to get a 
better view at the map. When selected, Log Data While Stopped allows you to continue collecting data 
when not moving. The minimum speed for data collection varies with the Sensitivity setting, ranging 
from 2 m/s to 10 m/s. The data collection interval significantly reduces below that speed.
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Help Menu

The Help Menu button provides access to this Help file, the MIH Setup Wizard, Product Information and Map 
Sources, and the About Anritsu Mobile InterferenceHunter dialog. See Figure 3-9.

View Help (F1): Opens this Help file.

Signal Identification: Opens the Signal Identification window. This is a .jpg file viewer with a title index pane 
(left side) and navigation buttons on each side of the image. Sample signal measurement displays with 
descriptions are included as a reference to common signal types. Additional images can be added by the 
user via drag-and-drop onto the title pane. The software will use the Title metadata field and prompt for 
a user title. Image files are copied to the program installation folder, typically C:\Program Files 
(x86)\Anritsu Company\Mobile InterferenceHunter\SignalID. 

Setup Wizard 

A guided setup wizard with on-screen instructions for setting up Mobile InterferenceHunter that includes:

• Mode Setting

• Audio Settings

• View Preferences

• Performance Settings

• Connection Setup

• Instrument Setup

Figure 3-9. Help Menu

Figure 3-10. Signal Identification Window
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Mode Setting

The Mode Setting menu is shown in Figure 3-11.

To set the MIH Mode Setting:

• Click Single Emitter to set the standard interference hunting mode

• Click Multiple Emitter to search for multiple interferer signal. Enter the peak threshold level that may 
indicate a source.

• Spectrum Clearing to search for signals of the same frequency based on the threshold set. Enter the peak 
threshold level that may indicate a source.

Figure 3-11. Mode Setting

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



3-3 Menu Bar MIH Graphical User Interface

3-14 PN: 10580-00416  Rev. F MX280007A UG

Audio Settings

The MIH Audio Settings menu is shown in Figure 3-12.

To set the MIH Audio Setting: 

• Click Voice Prompts to receive directions to the interferer while driving.

• Click Audio Tones to receive tones that fluctuate in pitch relative to the power level of the interferer 
signal strength.

 

Figure 3-12. Audio Settings
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View Preferences (page 1)

The MIH View Preferences (page 1) menu is shown in Figure 3-13. 

To set the MIH View Preference Settings (page 1): 

• Click Font and Button Size: to adjust the font size of the menu buttons and the sliding scale adjusts the 
size of the car on the map, Growing Breadcrumbs, and Cross Hairs.

• Click Growing Breadcrumbs: to indicate bread crumb size to indicate power levels.

• Click Cross Hairs to indicate more precisely of the location estimate.

Figure 3-13. View Preferences (page 1)

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



3-3 Menu Bar MIH Graphical User Interface

3-16 PN: 10580-00416  Rev. F MX280007A UG

View Preferences (page 2)

The MIH View Preferences (page 2) menu is shown in Figure 3-14.

To set preferences from View Preferences (page 2):

• Click Estimation Circle to show a circle of high probability for the RF source.

• Click Heat Map to show the probability of the RF source across the entire search area.

• Check the Log Data While Stopped to collect data while stopped.

Figure 3-14. View Preferences (page 2)
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Performance Settings (page 1)

The MIH View Performance Settings (page 1) menu is shown in Figure 3-15

To set the MIH View Preference Settings (page 1):

• Click Trace Mode as Normal, Min Hold, or Max Hold

• Check Squelch to set a minimum power signal threshold. 

• Click Search Grid Size as Normal of Large to search the area around your location in which an RF source 
is sought.

Figure 3-15. Performance Setting (page 1)

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



3-3 Menu Bar MIH Graphical User Interface

3-18 PN: 10580-00416  Rev. F MX280007A UG

Performance Settings (page 2)

The MIH View Performance Settings (page 2) menu is shown in Figure 3-16.

To set the Performance Setting (page 2):

• Slide the Sensitivity level scale is used to adjust how data is collected in different areas.

• Slide the Peak Detect Threshold scale to determine the amount of data collection is received to begin 
showing a location estimate.

Figure 3-16. Performance Setting (page 2)
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Connection Setup

The MIH Connection Setup menu is shown in Figure 3-17.

To set the Connection Setup menu:

• Click USB to use a USB connection

• Click Ethernet to connect through an Ethernet connection. To use Ethernet, Get the IP, Set the IP and 
DHCP connectivity.

• Test Connection to check the status of the connectivity. The status field will indicate a Pass or Fail. 

Figure 3-17. Connection Setup
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Instrument Setup

The MIH setup menu is shown in Figure 3-18/     

The Instrument Setup step allows you to remotely set up and view handheld instruments. This feature does 
not apply to all Handheld products as most of the newer models provide their own interfaces.

Check Online for Program Updates

Displays the installed version details shown below. 
 

Note Connect the instrument to the computer in use before running the wizard.

Figure 3-18. Setup Wizard Instrument Setup Window
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About Anritsu Mobile InterferenceHunter: Opens the About dialog that displays the MIH version, copyright 
date, and license key information. The license key information includes an instrument’s model and serial 
number, the license key, the version of the MIH software that the license key will work with, and the 
expiration of the license key. The Anritsu link at the bottom left corner of the dialog opens the Anritsu 
Web page. Show All Licenses will display expired and superseded licenses.

Figure 3-19. Help About Window

Note License keys shown are examples only.
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3-4 Signal Display Windows
There are four signal related display windows: Power vs. Time, Instrument Trace Display, Real-time Power 
Meter, and Power Scale.

Power vs. Time

Run Mode: During run mode, Power vs. Time displays the power levels in sequential time order with the time 
sequence starting at the left and the latest reading on the right. The signal with the highest power level is 
highlighted in bright yellow. When the window is full, the signal bars will reduce in width so that the entire 
collected data is always visible. The horizontal cross hair is another visual indicator of the amplitude of the 
highest signal level. Data to the Power vs. Time display updates about 1 time per second.

Pause Mode : Place the MIH program in Pause Mode to review the data collected. Click on a signal bar and 
the vertical cross-hair will move to that position. On the map, the Green Car will move to the breadcrumb 
associated with that signal bar and the Power Level, Longitude, Latitude and Counter 1 information will be 
displayed. Place the cursor on the Power vs. Time display area and right-click the mouse. A pop-up menu is 
displayed to assist you in reviewing the collected data:

Peak Search: Places the vertical cross hair on the highest level signal bar and the Green Car on the 
breadcrumb on the map with the highest signal level.

Delete Selection: During data collection, large amounts of insignificant data could be collected filling the 
Power vs Time display with not useful signal bars. Delete Selection allows you to remove signal bars not 
useful in determining the location of an interferer. 

1. Click on the left most signal bar of the group of signal bars to delete. 

2. Drag the cursor to the right of the unwanted signal bars. 

3. Right-click

4. Click Delete Selection on the pop-up menu. The highlighted section is deleted.

Trim to Selection: Keep a section of the signal bars collected. Click on the left most signal bar of the 
group of signal bars to keep. Drag the cursor to the right of the signal bars to keep, right-click then click 
Trim to Selection on the pop-up menu. The signal bars surrounding the highlighted section are deleted.

Delete All: Removes all of the signal bars from the Power vs. Time display and all data from the active 
data set. Right-click to open the pull down menu. Click Delete All. 

Figure 3-20. Power vs. Time Display

Note

For both Run Mode and Pause Mode, light yellow signal bars and short black hash marks are 
displayed. The light yellow signal bars are a result of crowding. As more signal bars are added to the 
display, some will overlap creating a light yellow signal bar. The short black hash marks indicate the 
actual values used in calculating the position estimate.
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Instrument Trace Display

Click the Display Instrument Trace button in the Toolbar to toggle this window on and off. It is off by default 
and not visible unless you turn it on. The placement of the spectrum analyzer instrument may not be in a 
convenient location for viewing when interference hunting. The Instrument Trace Display allows you to view 
the signal within the Mobile InterferenceHunter window. This window will update approximately once per 
second.

To view a larger version of this trace, double click on the Instrument Trace Display and the trace on the 
instrument will display in the Drive Map Display window. Therefore, no mapping or mapping data collection 
occurs. This window will be updated approximately 4 times per second. Click on the Drive Map Display window 
once and the Drive Map will return and mapping data collection resumes. This feature slightly affects the 
frequency of updates of the Power vs. Time bar graph and audio tones if turned On.

Figure 3-21. Instrument Trace Display

Figure 3-22. Instrument Display in the Main Window
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Copy, Save Trace Display

Right-click the trace display to show dialog as shown in Figure 3-23. 

Copy Thumbnail to Clipboard: Copy the trace display as a thumbnail to the clipboard.

Copy Full Trace Image to Clipboard: Copy the full trace image to the clipboard.

Save Thumbnail to File: Save the thumbnail display to a file.

Save Full Trace Image to File: Save the full image to a file.

Trace Spectrogram: Open displays the trace view in a spectrogram window as shown in Figure 3-24.

Figure 3-23. Trace Display Dialog

Figure 3-24. Trace Spectrogram
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Color Power Meter and Power Scale

The color power scales provide a color readout with the power meter readout to indicate the approximate power 
level at a glance. 

Color Power Meter Scale

This signal Real-time Power Meter updates are limited by the instruments sweep time and is available to see 
immediate power levels. Since the data collection rate is slower, this is useful to observe the actual received 
power level without waiting for the screen to update with a new point saved to the active data set. The current 
power level color correlates with the color power scale to the right. For example, if the power meter reading 
was –10 dBm, then the power meter color would show a green color scheme as this is the color scheme 
indicated by the color scale to the right. If the power meter measured –90 dBm, the power meter color would be 
red color scheme. 

Color Power Level Scale

The power scale displays the current color coding for the active data set. This color coding is used in coloring 
the breadcrumbs on the screen. The color scale changes as you accumulate data. The scaling in this window 
also indicates the power scale used in both the real-time Power Meter and the Power vs. Time bar graph as 
well as the color for the breadcrumbs.

Right-click the colored power scale opens the menu shown in Figure 3-26.  

Default: Displays the default color scale as shown in Figure 3-25.

Auto-Scale: Auto adjust power levels to view the full spectrum of power levels in the channel power window. 

1. Real-Time Power Meter Color Scale Window

2. Power Level Color Scale Window

Figure 3-25. Power Meter and Power Color Scale 

Figure 3-26. Power Level and Color Control

1

2
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Upper Value: Opens a dialog box to type in the upper power level of the color scale. 

Lower Value: Opens a dialog box to type in the lower power level of the color scale.

Color Map: Click to change the power level color scheme as shown in Figure 3-27.

Show Color in Power Indicator: Displays power level color in the real-time power scale window.

3-5 Drive Map Display
The map pane may be a map provided by Google/Baidu maps or one that you have downloaded from 
OpenStreetMap. On the map are various icons and markers used to indicate your position and also help locate 
the interference source. The map icons and markers are only drawn when data collection is active.

The Map

• Google/Baidu Maps: Using Google/Baidu as the map source requires an Internet connection while you 
are driving. Click Run. The Google/Baidu maps will discover the vehicle’s current location and display 
the map for that area. 

• Open Source Maps: Downloaded maps from OpenStreetMap does not require an Internet connection 
when running Mobile InterferenceHunter. Depending on the coverage area or the number of locations 
that are tested for interfering sources, multiple maps may need to be downloaded onto the tablet or 
laptop. See Product Information and Map Sources in Help for more details on using maps from 
OpenStreetMap.

• Image Maps (User Provided): User created maps stored at the C:\[user documents folder]\Anritsu 
MapFiles location. These are retrieved and opened by selecting Settings > Map Source > Open Map 
Image File or Installed Map Image File. 

The Green Car 

It represents your position on the map as you drive. When data collection is paused, click and move the yellow 
vertical marker in the Power vs. Time Bar Graph in the upper pane and reposition the car icon to a location of 
interest, for instance peak power locations. The data for the Real-time Power Meter, the Status Bar Power 
Level, Longitude and Latitude, and Power vs. Time Bar Graph counters will update with the car’s geographical 
position.

Breadcrumbs

Dots or small circles placed on the screen following the movement of the Green Car. It is the data collected – 
GPS coordinates and received power at each location. The color of each dot will be set in reference to the color 
and power level of the Power Color Scale. To see the dots during drive test, set them to grow in size as the 
power level increases. Click on Settings in the Menu Bar and click on Growing Breadcrumbs.

Cross Hairs

The horizontal and vertical lines intersect at the estimated location of the interferer. 

Figure 3-27. Power Level Color Control

Standard
Colors

Red to Green Green to Red
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Green Arrows

Once you have collected several data points, an arrow will appear on screen. This arrow indicates a suggested 
direction of travel towards the interfering signal. The arrow will be in one of three states: Forward, Backward, 
or two sideways arrows. If the current trend is increasing power the arrow will point forward. If the trend is 
decreasing power or moving away from the interfering signal, the arrow will point backward. If the trend in the 
power if fairly level, then you are probably moving more or less perpendicular to the direction of the interferer. 
This arrow will point in both directions, right and left. This is an indication that the location algorithm needs 
data in a different direction in order to make a decent approximation of the interferer location. Once you have 
enough data for Mobile InterferenceHunter to make an approximation of the interferer location, the direction 
arrows will be removed and either an Estimation Circle or Heat Map will be drawn. The Green Arrows are only 
available in Spot Mode.

Heat Map

The Heat Map covers a larger area of displaying the level of intensity of the interferer signal by color. A matrix 
of rectangles creates the heat map and the colors signify the probability that the pattern of observed power 
measurements would be caused by an emitter in that grid cell – green represents the strongest signal and pale 
blue/gray represents the weakest signal. For Drive Map Display, click to view either the Estimation Circle or 
the Heat Map. The Estimation Circle is the default view.

Figure 3-28. Heat Map with Breadcrumbs
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Estimation Circle

A colored Estimation Circle appears as more breadcrumbs with higher power levels are left on the map. When 
the position of the signal source becomes available, the Green Arrow is eliminated and replaced by the Circle. 
The Circle may be large at first but will reduce in size as more signal data is accumulated. This indicates that 
you are closer to the interfering signal source and that the power level of the interferer is increasing. Also, the 
default colors of the circle area, red and green, can be changed in the Color Mode setting. From the center of 
the circle looking out, the green areas of the circle depict how the breadcrumbs are dispersed for calculating the 
location of the interfering signal. If the Circle is heavily shaded red or one side of the Circle is a quarter to half 
shaded green then drive in the direction of the area shaded red to accumulate a more even distribution of 
breadcrumbs to calculate the location of the interferer. The Estimation Circle is not available in Multiple 
Emitter and Spectrum Clearing Modes. For Drive Map Display, click to view either the Estimation Circle or 
the Heat Map. The Estimation Circle is the default view.

Figure 3-29. Estimation Circle with Breadcrumbs
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3-6 Status Bar
At the bottom of the Mobile InterferenceHunter (MIH) window is the Status Bar which consists of status icons 
and information windows.

Icon Description

Program Indicator: 

Red: MIH program started but has not been operated.
Green: MIH is currently running.
Yellow: MIH is paused.

Audio Indicator: By default these functions are off and the indicators will be gray. 
Music Note: Indicates Audio Tone is on.
Speaker: Indicates that Voice Prompt is on. Adjust the volume by clicking on this icon 
then adjusting the slide bar to the desired volume level.

Squelch Limit: This symbol is colored white and black when active.

Sensitivity: Indicates the sensitivity level. Sensitivity is used for Single and Multiple 
emitter Modes. It does not apply to Spectrum Clearing Mode.

Min/Max Hold: 

Min Hold: Indicates Min Hold is active.
Max Hold: Indicates Max Hold is active.

GPS Satellite Indicator: 

When an external USB GPS receiver is connected:

Gray: Indicates GPS is not active or no satellite fix.
Light Red: Indicates less than 3 satellites are fixed.
Yellow: Indicates 3 satellites are fixed.
Green: Indicates more than 3 satellites are fixed.

Timers: Timer 1 (left): Counts the elapsed time since data collection started. It will 
continually run till the program is exited, although the display will only be updated 
while measurements are being collected.
Timer 2 (right): Counts the actual data collection time. Click Pause to stop counting 
Click Run to restart.

Mode: Displays the selected measurement mode - Single Emitter, Multiple Emitter, 
and Spectrum Clearing. The default selection is Single Emitter mode. Click the Data 
Collection Start button. The connection is made with the instrument, the display will 
change to Connected.

Power Level: Displays the real-time power numerical value. If Squelch is on, the 
background color is green for levels above the Squelch Threshold, and yellow for 
levels below the Squelch Threshold.

GPS Coordinates (left): Displays the longitude and latitude of the vehicle location.

Map Center Coordinates (right): Displays the center of the map’s longitude and 
latitude coordinate. As the map changes with the movement of the vehicle, the map 
center coordinate changes.

Figure 3-30. Status Bar
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Counters: There are two counter displays that relate to the Power vs. Time window. 
The one on the left designates the power bar that the bright yellow vertical line is 
selecting and the vehicle position when in Pause mode. The display on the right 
indicates the total number of bars in the window.

Icon Description

Figure 3-30. Status Bar
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Chapter 4 — Hunting Interference Signals

4-1 Introduction
This section details hunting interference signals with the MIH software.

Recalling Saved/Recent Settings

Load previously saved settings into the Mobile InterferenceHunter software using:

Recall Saved Settings

1. Click Recall Saved Settings in the File menu and the Open window displays. 

2. Click the desired configuration file with the extension .mih. 

3. Click Open. Configuration settings are loaded into the Mobile InterferenceHunter software. 

Recent Settings

1. Click Recent Settings from the File menu.

2. Choose from a list of no more than 10 setting files saved to the laptop or tablet. 

Selecting the Mode

Select the desired type of interference hunt that is going to take place. Switch modes during or after 
acquisition, for further analysis.

Scan Driving (Initial Perimeter Survey): Use this mode to search for an interferer in a general area. This mode 
works well with the View set to Heat Map. The dark lavender shaded area on the drive map indicates an 
approximate area where the interferer could be. Once an interferer’s general location has been 
determined, refer to “Creating a Drive Route” on page 4-7 to hone in on the signal in this area.

Spot Driving (Standard Operation): Hunting for a single interfering signal.

Multiple Emitter: Hunting for multiple interferer transmitters such as cable TV leakage.

Spectrum Clearing: Hunting for multiple transmissions of the same frequency whose power exceeds the 
threshold set by the user. Screen images can be automatically saved when the threshold is exceeded.

Time Difference of Arrival (TDOA): Use TDOA to locate interference sources and other modulated 
broadcasters. TDOA is not a driving mode like the other modes mentioned above. For TDOA, you must 
have access to at least three remote spectrum monitor probes (MS2710xA). Refer to “Setting Up TDOA” 
on page 4-12 when using this mode.

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



4-2 Creating, Importing, and Viewing Base Stations (Open Source Only) Hunting Interference Signals

4-2 PN: 10580-00416  Rev. F MX280007A UG

Selecting the Map Source

Click a map from the map sources to use in the map display. For more on loading maps, see 
Chapter 2, “Loading Maps”. 

Google/Baidu Maps: The Google/Baidu map will identify the vehicle’s current location and display the map for 
that area.

Open Source Maps: Open a folder where Open Source maps are saved. Click any .shp file and then Click 
Open to load the map. Depending on the coverage area or the number of locations that are tested for 
interfering sources, multiple maps may need to be downloaded onto the tablet or laptop. Click a map 
from a map source to use in the map display – Google/Baidu map or a map from any open source map. 
See Product Information and Map Services in the Help Menu.

Show current OSM Map: Displays the name of the Open Source Map in use.

Open Map Image Files (User provided): Opens a browse dialog to search anywhere on their PC for a JPG or 
PNG file.

Installed Map Image Files: Opens a sub-menu that lists all of the JPG and PNG files in the Anritsu MapFiles 
folder stored in C:\[user documents folder]\Anritsu MapFiles. 

4-2 Creating, Importing, and Viewing Base Stations (Open Source Only)
A base station list file (.lst) is a plain text file with a header line and a line-by-line delimited list of base station 
details. These details must be in order and can be delimited with a comma, tab, or semicolon. The first line is a 
header for the user and is ignored when importing the list. Each of the remaining lines is for a single base 
station, where the first two numbers are the decimal latitude and longitude, respectively. Next is the base 
station name or other identifying information. The last number is an angle, measured clock-wise from North, 
and is optional. Base stations sometimes have an orientation and the angle is the direction an antenna points, 
or the center of the beam width. Many base stations have three sectors and this would be the angle from North 
of the center of the alpha sector. If you look closely at the icon on the map, there are three sectors shown and 
one of them has a black line through the middle – this should be in the direction indicated in the .lst file (see 
Figure 4-1).

Below is an example of three separate base station entries, the first of which is shown in the image below:

32.869333, -117.216278, DOYLE PARK PCS, 56
33.068856, -117.152606, ELFIN FOREST PCS, 44
33.037778, -117.239167, ENCINITAS RSF PCS, 52

To import a base station list, you must be using an open source map that covers the area of the base stations. 
Google/Baidu maps do not support viewing base stations.

1. Click Settings | Map Source | Importing Base Stations (Open Source only). 

2. Click the Import File button to find the directory and folder of the Base Stations list (.lst). When selected, 
the latitude, longitude and description of the site will be displayed in the list.

3. Click the Create Map Overlay to place the base station locations on to the current map. 

4. Click View Base Stations on Map if Present to see if there are any base stations in the Drive Map 
display. Base station symbols will display on the map as shown below when this function is selected. 
Note that your map must cover the area of where the imported base stations are located.    

Figure 4-1. Base Station Symbol

          ООО "Техэнком"     Контрольно-измерительные приборы и оборудование     www.tehencom.com          



Hunting Interference Signals 4-3 Configuring Display Elements

MX280007A UG PN: 10580-00416  Rev. F 4-3

4-3 Configuring Display Elements
This section covers how to configure many display elements to suit your particular situation and preferences.

Setting Signal Strength Indicators

There are two position-estimate indicators that cover the area where an interferer could be – Heat Map and

Estimation Circle. Only one of these can be selected for viewing at one time. Click either Estimation Circle or

Heat Map. The check-mark denotes the indicator selection. 

Showing Cross Hairs

Adds a horizontal and a vertical line that cross at the estimated location of the interferer.

Setting the Button Size

Provides four button size selections, 32 x 32, 64 x 64, 96 x 96, and 128 x 128. The buttons will scale to fit the 
toolbar if the button size selected is larger than what can be accommodated by the toolbar size. Expanding the 
window size will grow the size of the buttons until they reach the maximum size selected.

Setting the Menu Font Size

Click a menu font size from the Menu Bar, the sub-menus, the Status Bar, and most dialogs. The font size 
selections are 9, 10, 11, 12, 14 and 16. The font size affects the amount of information displayed on Status Bar. 
As the font size increases, status parameters may be removed from view depending on the window size.

Growing Breadcrumbs 

In its default setting, breadcrumbs’ color changes but still may be difficult to see while driving. Click the 
breadcrumb size increases as the power increases. With Growing Breadcrumbs set, breadcrumb power levels 
are denoted not only in color but with size.
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4-4 Setting up Audio and Voice
Audio tones and voice prompts assist the driver while operating the Mobile InterferenceHunter. For a detailed 
description of audio tones and voice prompts, see Section  “Settings Menu” on page 3-9. 

Setting Audio Tones

Click to activate. The music notes turn green in the Status Bar. 

Setting Voice Prompts

Click to activate. The speaker turns yellow in the Status Bar. 

Selecting the Voice

1. Place the cursor on Voice Selection to display the list of voices. 

2. Click the desired voice. 

4-5 Setting Min/Max Hold
For a detailed description of setting Min/Max Hold, see Section  “Settings Menu” on page 3-9. 

Click to activate. The symbol associated with the desired “hold” will be displayed in the Status bar.

4-6 Setting the Squelch Limit
For a detailed description of the Squelch Limit function, see Squelch Limit in Section  “Settings Menu” 
on page 3-9. 

1. Click the Squelch Limit dialog window. 

2. Enter the desired peak threshold level or move the slider to a level that may indicate an emitter source.

3. Click ON. 

• The Squelch Limit icon is highlighted in black and white. Turn off this feature at any time during 
the interference hunt. 

4-7 Setting the Sensitivity
For a detailed description of the Sensitivity function, see Sensitivity in Section  “Settings Menu” on page 3-9. 

1. Click Settings. 

2. Click Sensitivity.

3. Click on the selection that closely resembles the area you are hunting for an interferer or “0” to display 
only raw data taken.

4. Click Peak Detect Threshold. 

5. Click High. If you are certain you are in the right area of the interferer but not seeing a location 
estimate, select Medium or Low.

Note Using this feature lengthens the data collection time. You will need to reduce your driving speed.
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4-8 Logging Data While Stopped
Normally, the Mobile InterferenceHunter will not collect data when you come to a stop. Selecting 
Log Data While Stopped allows you to continue collecting data when stopped. The minimum data collection 
rate varies with sensitivity, ranging from 2 m/s to 10 m/s. The data collection interval significantly reduces 
below that rate.

4-9 Searching Grid Width
For a detailed description of the Search Grid Width function, see Sensitivity in Section  “Settings Menu” 
on page 3-9. Click to set grid width to 4, 8, 16, or 32 Kilometers.

4-10 Displaying the Instrument Trace
The placement of the spectrum analyzer may not be in a convenient location for viewing when drive testing. 
The Display Instrument Trace button allows you to view the signal within the MIH window. This window will 
be updated approximately once per second.

4-11 Setting Up the Spectrum Analyzer
Interference hunting will take place in the Channel Power measurement mode of spectrum analyzer 
measurements. The following are basic instructions to set up this mode. For detailed instructions to configure 
your instrument, review the user guide specific to your instrument. 

Setting Up the Channel Power Measurement Mode

1. Power on your instrument. 

2. Click the Spectrum Analyzer Measurement mode. 

3. Ensure the GPS is On if using the instrument GPS option.

4. Click Channel Power Measurement (does not apply to MS2710xA instruments). 

5. Enter the frequency of the suspected interferer as the Center Frequency.

6. Set both the Channel Power Width and Span. It's best if you set the channel width to be as narrow as 
possible while still covering the signal of interest. (The MS2710xA instruments only use the Span).

7. Set the amplitude reference level to –40 dBm and turn on the preamp or IF gain if needed to see the 
signal. The Reference Level must be –40 dBm or below in order to turn on the preamp or IF gain. Bursty 
signals such as Wi-Fi or DECT signals may be easier to find if you set the spectrum analyzer to Burst 
Detect mode, if available.

If the network connection is not yet established, refer to “Configuring the Computer to Instrument 
Connections” on page 1-3. The instrument is ready for interference hunting.
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4-12 Installing the System into a Vehicle
Setting up the hardware in your vehicle for hunting:

1. Secure the spectrum analyzer in the passenger seat. 

2. Connect the antennas.

3. Place the RF magnet mount omni-directional antenna on the vehicle rooftop and run cables to the 
interior. If the RF antenna does not also contain a GPS antenna, mount the GPS antenna on the roof.

4. Connect the antennas to the spectrum analyzer.

5. Connect the instrument’s power cable to vehicle power (cigarette lighter adapter).

6. Set up the computer car mount (if used) according to the manufacturer’s instructions.

7. Make all connections between the instrument and computer as described in “Configuring the Computer 
to Instrument Connections” on page 1-3.

8. Verify that all equipment is secure in the vehicle and provides convenient visibility and access while 
driving. Also verify that no cables are under stress and that proper strain relief is used.   

Danger

Use a passenger to help with operating the equipment while driving on the hunt. Do not attempt to 
change the settings or otherwise operate the equipment while operating the vehicle. It is safe to pull 
to the side of the road before changing any settings or operating the equipment or computer. Follow 
all local regulations and always operate your vehicle in the safest manner possible.
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4-13 Creating a Drive Route
A drive route should be created to not directly pinpoint the direction of the interferer, but to create a drive 
perimeter that will allow you to collect many data points that will closely direct you to the interferer. A drive 
route is typically created directly in Google Maps. 

1. Click Google Maps under Map Source in the Settings menu.

2. Click Create a Drive Route in the File menu.   

3. Click Open in Google Maps and follow the on-screen instructions for using Google Maps and sending the 
route to your personal navigation device.   

Once the field tech has received the drive route on his phone, he can use the audio commands to direct him 
through the route perimeter around the interferer.

Note It is better to create a drive route at the office than out in the field.

Figure 4-2. MIH-Navigation Window with Driving Points and Instructions Example

Note
Confirm that the Google Maps account used on the computer and your phone used for audible 
instructions are signed into the same Google Maps account.
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4-14 Finding the Interferer
Mobile InterferenceHunter is not designed to provide directions to the precise location of an interferer source. 
MIH will get you very close to the exact building or source. In the final stage of the driving portion of the hunt, 
watch the power bars and try to park your car as close to the maximum bar readout as possible. The source of 
interference will be very near.

Preparing for the Drive

Below is a quick rundown of the steps needed to get set up for a hunt.

1. Place the mag-mount antenna on top of the vehicle. 

2. Connect it to an Anritsu spectrum analyzer. 

3. Power on the instrument.

4. Set the instrument measurement to Channel Power (review your instrument user documentation for 
details on setting up this measurement mode for your model).

5. Locate the interferer signal on the instrument. 

6. Connect the computer and Anritsu Spectrum Analyzer via Ethernet or Wi-Fi.

7. Run the MIH program.

8. Set up the MIH software for interference hunting, starting with Scan Driving mode to isolate the general 
interferer signal.

9. Switch to Spot mode to pinpoint its location. 

Searching the Source of Interference

Anritsu strongly suggests that a passenger be available to accompany the driver to assist with the navigational 
instruction. Use the Voice Prompts and/or Audio Tones to minimizing glances at the display.

Start MIH in Scan Drive mode at a location where you know an interference problem occurs, such as a base 
station that is having interference problems. Obtain the interferer signal from your starting location, drive in 
the direction of the signal. In the Power vs. Time display, observe the increase or decrease in signal level. If the 
signal level decreases over time, most likely you are driving away from the signal source. If the signal level 
increases over time, you are probably heading in the direction of the signal source.

Use the breadcrumb color and size to indicate the relative location of the emitter as well as the heat map color 
shading. A large yellow breadcrumb generally means higher signal power suggesting you are closer to the 
source. A small dark breadcrumb means low signal power and that you are probably far from or driving away 
from the signal source. Darker shaded areas of the heat map indicate stronger signals. 
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The example below is from Scan Drive mode showing that you are driving toward the signal. Note that MIH 
will only scan out to the Search Boundary, the size of which is set via Settings | Search Grid Width.   

Figure 4-3. Approaching the Interferer
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The example below is showing that you have driven past the signal and have isolated a general area of where 
the interferer could be, shown by the darker shaded region. The next step is to circle around the shaded area to 
continue narrowing it down into a smaller circle before switching to Spot mode.

Figure 4-4. Isolating the Interferer
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Once you have isolated the general area, switch to Spot mode to further isolate the signal and start collecting 
signal data.

As more data is collected, a green arrow will show on the map pointing you in the general direction of the 
signal source. A shadow circle replaces the arrow and will appear on the map as additional data is 
accumulated. The shadow circle is the general area where the signal is coming from. Its initial size may be 
large but will decrease in size as you get closer to the signal source and the power level of the interferer 
increases.

At times you may want to park and evaluate the data received. Once a very close approximation on location 
has been established, get out of the vehicle and proceed on foot with a handheld instrument and directional 
antenna to find the exact emitter location.

Figure 4-5. Pinpointing the Interferer
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4-15 Setting Up TDOA
TDOA is not a mobile hunting mode, but can be used to compliment a mobile interference hunt. TDOA uses the 
Time Difference of Arrival technology introduced with the Anritsu Vision software, which can now be used 
with MIH to help you locate a general area of where an interfering signal may be found. This gives you a good 
idea of where to start Creating a Drive Route before using the mobile modes with a spectrum analyzer in the 
vehicle. This is easily accomplished in the office before you leave, or while out in the field and connected to a 
remote spectrum monitor system.

Remote Monitoring Probes positioned in a triangular pattern perform TDOA to identify a stationary signal’s 
longitude and Latitude coordinates. Use either Google Maps™, or a bit map to identify and geo-locate the 
interferer’s signal source. 

To use TDOA to locate interference sources, the following considerations need to be made: 

• Three probes (Anritsu MS2710xA series remote spectrum monitors) are required to do the TDOA 
triangulation of the RF source. Best results will be achieved if the interferer source is contained inside a 
virtual triangle made by connecting the remote spectrum monitor locations. TDOA works for sources 
outside of this triangle too and it may be used to locate a source that is many kilometers outside the 
triangle, but it is more accurate for sources that are close by. 

• An Internet connection for the computer is required for MIH to connect to the remote probes. If this is 
not already built into the computer, a USB mobile broadband adapter or Wi-Fi adapter to a local hotspot 
from your cellular provider can be used. 

• The source must be modulated. TDOA looks for features in the RF spectrum as measured at three 
locations. Those features are time-aligned, and the difference in the time for the signals to reach each 
receiver is used to calculate the location. If the signal of interest does not have features that can be 
aligned in time, then TDOA will produce meaningless results. Typically, that means the signal must be 
modulated. 

• A clean IQ produces much more accurate results. The better you can set up the spectrum monitor to 
capture IQ data, the more accurate the position estimate will be. This means more time may be needed 
to set up each remote monitor and to adjust the frequency, span, reference level, and preamp settings to 
get the best possible IQ capture. Strong signals that are close by will be relatively better, but weaker 
signals, and especially distant signals, take some care to get meaningful results. This implies that you 
should either have a dedicated MIH operator in the vehicle, or be parked so you can devote your 
attention to setting up the measurement.

• Distance matters because of the uncertainty in any measurement made. You are looking for the 
intersection of three lines and for where those lines intersect at nearly right angles, then any 
uncertainty in the line positions produces a similar uncertainty in the intersection. However, if the lines 
approach each other at very shallow angles, then the lines may be within the distance of uncertainty for 
several kilometers. Distant sources outside of the triangle of the remote monitors will almost always 
produce lines that have very small incident angles, and that can greatly multiply the uncertainty in 
position. 
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4-16 Flux Density
The MS2090A Field Master Pro spectrum analyzer must be used when measuring flux density. MIH measures 
and displays the flux density of the power/m2/ MHz (dBm/m2/MHz) or (dBW/m2/MHz). 

Connect to Measure Flux Density

To measure flux density, you must connect to the MS2090A. From the Settings menu, click Spectrum Analyzer 
Connection as shown in Figure 4-6. 

The MIH Connection Setup dialog appears as shown in Figure 4-7.

Testing the connection must be complete before the MIH identifies and uses the MS2090A spectrum analyzer.

1. Type the IP address of the MS2090A. 

2. Click Test Connection. 

The connection status will indicate Passed of Failed. If the Test Connection indicates Failed, troubleshoot the 
failed connection and retry. The flux density measurement options will only be available with the MS2090A 
when connection is complete and Passes.

Setting up the MS2090A for Flux Density Measurements

The flux density application may be used with calibrated antennas. Using the MS2090A, field strength mode 
can be used to choose an antenna with calibration factors. A listing on Anritsu antennas with calibration 
factors is available in the MS2090A. Additional antennas may be added. See the MS2090A User Guide for 
additional information.

Figure 4-6. Connect to Measurement Source

Figure 4-7. MIH Connection Setup Dialog
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Once connected to the MS2090A, Power Detection Mode will be available in the Settings menu. Click Power 
Detection Mode to display the measurement submenus shown in Figure 4-8.

Channel Power (dBm): This is the normal MIH measurement mode. 

Flux Density (dBm/m2/MHz): Provides flux density in the dBm per meter2 per MHz.

Flux Density (dBW/m2/MHz): Provides flux density in dBW per meter2 per MHz.. 

Clicking one of the flux density measurement submenus noted above displays an information text line above 
the map window as shown in Figure 4-9. 

The information text line shows the Flux Density Measurement is active and the Anritsu Antenna part 
number being used. Check the Show Location checkbox to show an estimation location grid as shown in 
Figure 4-10. This feature is available when Mode is set to “Spot Driving: Single Emitter (Standard 
Operation)”. The spot driving function is chosen by clicking on the green triangle in the left-hand column of the 
interface depicted in Figure 4-10 on page 4-15. The Spot Driving move is the 2nd green triangle from the top.

Figure 4-8. Power Detection Mode

Figure 4-9. Flux Density Measurement Active
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Collecting Flux Density Data

From the Tool Bar, click “Start data collection”. As a default, the Channel Power measurement begins. The 
field strength measurement begins when the flux density measurement type is selected from the Power 
Detection Mode menu. The real time measurement results are displayed in the power meter/flux density 
window and status bar shown in Figure 4-11. The data collected can be saved as a (.log) file and then exported 
as a (.kml) file as described in Section  “Export Drive Log to KML” on page 3-3.

Figure 4-10. Show Location

Figure 4-11. Channel Power and Flux Density
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4-17 Using TDOA
For clarification of the TDOA functionality, we use the Vision Simulator program to develop the single screen 
interface as shown in Figure 4-12. Although the simulator does not understand and respond to all Probe SCPI 
commands, it does respond to the complete sub-set of commands that Vision uses. 

Typically, a map is loaded from an existing user file. The TDOA Graphical User Interface provides the 
approximate location of the simulated probes along with a series of locations that are used to simulate RF 
sources. These RF source locations can represent:

• Interference sources when working with Power of Arrival (PoA) or Time Difference of Arrival (TDOA). 

• A series of locations when tracking a moving RF emitter.

Note
The Vision Simulator Program and the simulated RSMs do not have regional settings; therefore, the 
numbers are displayed in US-English notation.

1. Toolbar

2. Probe Settings

3. TDOA Capture Settings

4. Status Bar

Figure 4-12. TDOA Graphical User Interface

2

4

1

3
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TDOA Toolbar

The TDOA’s menu toolbar descriptions are listed in Table 4-1.

Table 4-1. TDOA ToolBar

Icon Description

Mobile InterferenceHunter - TDOA: This program icon is located at the top-left 
corner of the Source Locator GUI screen. Click provides GUI display screen-view 
sizing and positioning choices.

• Restore: Resets the screen display to the default view. This selection is 
active only after Maximize has been selected and the GUI screen is in a full 
screen mode. Restore is normally grayed and becomes available after 
Maximize is active. 

• Move: Move the display screen.

• Size: Click a corner of the display and resize the display by dragging the 
corner.

• Minimize: Minimizes the screen to the bottom tray. Click it from the tray to 
view the screen display. 

• Maximize: Maximize the screen to full size.

• Close: Closes the screen display. 

Start: Starts the TDOA tracking. 

Clear: Removes all measurement and map tracking results.

Report: Generates a TDOA report that includes the probe information, search 
parameters and the current displayed map results. 

Save: Opens a dialog box to enter the name of a file to save everything shown as 
a configuration file (*.cfg). Save does not save the results that appear in the 
Mobile Tracker Index-Latitude-Longitude box. Can also save the most recent IQ 
captures data as Binary IQ Data (*.IQ).

Load: Search and load a saved configuration file.
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Probe Settings

The Probe Settings section provides text boxes to type or enter the probe setting parameters. Probe 1, Probe 2, 
and Probe 3 identify the communication setting parameters for each probe as shown in Figure 4-13.  

The Probe Settings section is described in Table 4-2.

Figure 4-13. Probe Settings

Table 4-2. Probe Settings and Control Buttons

Icon Description

Probe 1,2,3: Identifies each RSM Probe. Each Probe label is a button. Click each 
probe label to display its RMS Status dialog as shown below. The RSM Status 
dialog provides details of each probe as shown:

• Model: The model of the RSM. 

• Options: The RSM options installed.

• Serial #: The serial number of the RSM. 

• Firmware: The firmware installed.

• GPS: Indicates the GPS as GOOD FIX (Strong GPS signal connected). NO 
FIX (GPS signal is too weak or none found). The RSM coordinates are 
displayed.

• RSM in use: Flag indicating the RSM is in use and also displays the 
end-user. In this case the end user is the Simulator. If the RSM is not in use, 
the flag will indicate – RSM is available for use.

Hostname: Type in the Host name settings. The URL Hostname is the 
communication link to the Remote Spectrum Monitors. 
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TDOA Capture Settings

Enter the TDOA Capture Settings section as shown below in Figure 4-14.

Channel: Type or select the probe channel.

Ref Level: Type or select the RSM probe Reference Level.



Preamp: Click the Preamp check box to activate the Preamp for each probe.



Delay (ns): Type or select a delay time. The delay time selections are in nano 
seconds.



Figure 4-14. TDOA Capture Settings

Table 4-2. Probe Settings and Control Buttons

Icon Description
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The TDOA Capture Settings section is described in Table 4-3.

Status Bar

The Status Bar provides the probe sweep details.

Elapsed Time: The total time taken for the set of measurements in the current result.

Previous Time to Measurement: The time the most recent measurement took. If this number gets very large, 
one of the RSMs might be off-line.

Average Time: The average time for each IQ capture and position calculation.

Count: Due to the uncertainty in each position estimate, several sequential measurements and average the 
results are performed. This is the number of measurements in the current result.

Table 4-3. Capture Settings

Icon Description

Center Freq: Type the center frequency and then select the frequency terminator.

Capture BW: Click to open the Capture BW frequency list and select the 
frequency. 

Automatically set reference level: Click the check box to set reference levels 
automatically. 

Wait for signal peak: Click to enter a check-mark to set – Wait for signal peak. 

Figure 4-15. TDOA Capture Settings

Wait for signal peak
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4-18 File Management

Opening a Log File

Click Open Log File in the File menu and open the desired file, (Ctrl+O on the PC keyboard). Viewing a log file 
is useful for reviewing test results and documenting hunting excursions. The .log file can also be opened as 
playback file. A playback file is like reviewing the gathered data as a movie. To open a log file for playback, 
select the desired Replay mode from the lower right selection box. When viewing a log file in playback mode, 
use the Space Bar to fast forward through the traces and the Esc key to pause the playback. Log files can also 
be opened and appended to the currently open data. This option is also selected via the lower right selection 
box. 

Figure 4-16. Open Log File Window
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Importing and Viewing  .loc Files

Anritsu “Vision” program location (.loc) files can be imported, opened, and viewed on the MIH screen. Files 
that can be imported from Vision include:

• TDOA (Time Distance of Arrival)

• POA (Power of Arrival)

• AoA (Angle of Arrival)

To open a .loc file:

1. Click Import Location Estimate from the file menu as shown in Figure 4-17. 

2. Click a .loc file as shown in Figure 4-18.

Figure 4-17. Import Location Estimate

Figure 4-18. Click .loc file to Import
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3. Import the TDOA, POA, and AoA file to view on the MIH screen as shown in Figure 4-19.

Figure 4-19. View Imported .loc files

POA
Location Estimate

TDOA
Location Estimate

AoA 
Location Estimate
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Saving a Log File

Click Save Log File in the File menu and the Save As widow opens, (Ctrl+S on the PC keyboard). Use the date 
and time stamp for the name or create your own. Click Save. If you clear the data before saving it, you will not 
be able to get it back. 

Auto Archive

MIH can collect data for many hours. Data is not written to a file, but is held in memory until the user stops 
data collection and choses to save. If a trace graph is open, then it is also saving full trace data for each data 
point, and this can get very large after a few hours. 

There is no set time limit that the data is saved, but there is a certain point count. When more than 5,000 data 
points are collected and the trace window is open, then the data will automatically be saved as a log file and 
the last 600 points will remain in the current data list. The rest is removed to make room in memory for 
continued data acquisition. 

Auto archive is a feature that cannot be turned off. 

Capturing the Map and Signal Windows

Click Capture Screen in the File menu, (Ctrl+C on the PC keyboard). Captures the current drive map display, 
Power vs. Time Display, Instrument Trace Display, Real-time Power Meter (if displayed), and the Power Scale 
and saves it to the directory folder labeled Anritsu ScreenShots. The captured screen is in PNG format and 
labeled with a date and time stamp. To view the captured image, click Screen Capture Folder in the File menu 
and the folder labeled Anritsu ScreenShots will open.

Saving Current Settings

Click Save Current Settings in the File menu and the Save Program Settings File window opens. Name the file 
and Click Save. Most of the MIH settings and key instrument settings are saved. The extension .mih will be 
added to the name.

Recalling Saved Settings

Click Recall Saved Settings in the File menu and the Recall Settings widow opens. Select the desired 
configuration file, extension .mih. Click the Open button. Configuration settings are loaded into the Mobile 
InterferenceHunter software. If the instrument is not connected to the computer a warning dialog, 'The 
Anritsu Spectrum Analyzer is no longer connected.', will pop up indicating the Spectrum Analyzer is 
disconnected and to check the connection. After checking the connections, click Retry.
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 Anritsu utilizes recycled paper and environmentally conscious inks and toner.

Anritsu Company
490 Jarvis Drive

Morgan Hill, CA 95037-2809
USA

http://www.anritsu.com
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